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Microtique CLASS 2nd Edition to
Creative Solutions Accounting

Conversion Guide
The Utilities / Data Conversion / CLASS command in Creative Solutions Accounting (CSA) is provided to
convert data files from Microtique Client Ledger Accounting Support System 2nd Edition (CLASS2) into the
Write-Up Solution for Windows bundle of modules within CSA. This conversion guide explains the necessary
steps to convert your data, to identify the fields that will not be converted, and to document exceptions that you
may encounter during the conversion process. The last section of this document explains the steps you should
take to verify that the converted data is correct.

Please review this document in its entirety before actually beginning the conversion process for a client.

CONVERSION PROGRAM OVERVIEW
The overall objective of the CLASS to CSA conversion utility is to provide a comprehensive conversion of your
CLASS2 data to CSA. However, due to differences in processing calculations and data structures between CLASS2
and CSA, some CLASS2 data cannot be converted. Therefore, you should not expect to exactly duplicate results
from CLASS2 using the converted data without adding or modifying the appropriate data in CSA. The specific
items that cannot be converted and conversion exceptions are listed in the section in this document entitled
“Conversion Notes and Exceptions.”

Note: Payroll check information is not converted from CLASS2 to CSA. It is recommended that you convert your
client data at the beginning of a new quarter or year, as some reports my not calculate correctly if you convert the
client data in the middle of a quarter. Also, some manipulation of your data in CLASS2 may be required prior to
conversion. For more information, please refer to the section of this document entitled “Processing Steps Required
for Each Client Prior to Running the Conversion Program.”

PROCESSING STEPS REQUIRED FOR EACH CLIENT PRIOR
TO RUNNING THE CONVERSION PROGRAM
! We recommend that you review the CLASS2 addition/deduction codes and their associated descriptions for each

client prior to running the conversion. A Transfer of Miscellaneous Additions/Deductions dialog is provided
during the conversion so you can translate the client’s CLASS2 additions and deduction codes (MD1-MD11) to
the allowable CSA earnings and deduction codes. The dialog will present the code, GL account, and description
as entered in CLASS2. If the description does not adequately identify what the code is used for, you should
modify the description to specifically identify the purpose of each code.

! The conversion process includes only transactions that have been posted to the general ledger. Unposted
transactions are not converted. Before you begin the conversion of any client, you should verify in CLASS2 that
all transactions have been properly posted by running any Post and Print/Display option. Make sure the posting
process is completed without errors.
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CONVERTING AND IMPORTING A CLIENT INTO CSA
Use the following steps to convert and import a CLASS2 client into CSA. You may refer to this document for all
information regarding this conversion.

1. Start the CSA program by clicking the desktop icon for Creative Solutions Accounting.
2. Create a new client in CSA by choosing New Client from the File menu. (For more information on creating

a new client, choose CSA Help Topics from the Help menu and then; in the Index tab of the Help dialog,
choose New Client [File menu].

Note: When adding the client to CSA, you must complete the current period end date, current fiscal year end,
and current payroll end date exactly as they appear in the CLASS2 system. If you are converting general
ledger and payroll information, you will also need to use the General Ledger Solution and Payroll
Compliance Solution modules when adding the client.

3. From the Utilities menu, point to Data Conversions and then choose CLASS.
4. In the first field of the Microtique CLASS Conversion dialog, enter the location of the CLASS2 data files

that you wish to import into CSA.
Example: If your CLASS2 data files are on drive C, you would enter C:\Class2. You can locate this
information in the CLASS2 program by selecting Special from the menu toolbar and pressing S for System
Initialization. The paths for the Clients will be listed on this screen.

5. Enter the location of your CLASS2 archive data path.
Example: If your CLASS2 archive data path is set up to be drive A, you would type A:\. You can locate this
information in the CLASS2 program by selecting Special from the menu toolbar and pressing S for System
Initialization. The path for the Archive will be listed on this screen.

6. In the Client to import field, enter the company ID you want to import. It may be useful to print a list of
clients from the CLASS2 program before beginning. The Print List of Clients report will show the company
ID and the company name.

7. If you wish to convert the employee earnings totals, mark the Convert Employee Earnings checkbox.
8. Click the Import button.
9. If any employees have balances for miscellaneous additions/deductions, the Transfer of Miscellaneous

Additions/Deductions dialog will open automatically. This dialog is used to translate the employer
additions and deductions codes from CLASS2 (MD1-MD11) into the accepted CSA payroll item codes. After
entering the necessary information, press F10 to continue. For more details, see the section in this document
entitled “Conversion Notes and Exceptions.”

10. You will be prompted to insert the archive diskette into the archive path. If the archive path is a hard drive,
press ENTER. If you use a floppy for the archive drive, after each archive disk has been completed you will
see a prompt asking if there are any more archive disks to load.
•  You should only use archive diskettes, which contain data within the current fiscal year. No archive

data prior to the current fiscal year can be imported.
•  If you choose to convert transactions only for the current period of the current fiscal year, you may press

ESC when prompted to load the next archive diskette.
11. Once the import has finished, you should make the necessary changes or corrections to the converted data as

specified in the sections of this document entitled “Items Transferred During Conversion of CLASS2 Data”
and “Conversion Notes and Exceptions.”

ITEMS TRANSFERRED DURING CONVERSION OF CLASS2
DATA
The following tables are provided to identify CLASS2 fields that will be converted to the CSA program. The tables are
organized by CLASS2 and CSA screens and denote the necessary CSA screen navigation.
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CLASS2 General Ledger Account Information
MICROTIQUE
CLASS 2ND
EDITION Field
Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting
Field Name

Comments and additional information

Account Setup | Chart of Accounts
Acct#

See Conversion Notes and Exceptions for more
information on the conversion of the account
numbers

Chart Section -
Starting Account
Number

Setup | Chart of Accounts
Type

This code determines whether the account is marked
as an asset, liability, equity, revenue or expense
account. The conversion uses the chart of accounts
section identifiers to determine the account type.

Description Setup | Chart of Accounts
Description

The description in CLASS2 is 30 characters long and
the description in CSA is 29 characters long. Only
the 1st 29 characters of the CLASS2 description will
be converted

Current Year Balances Setup | Chart of Accounts
19yy or 20yy Balance

See Conversion Notes and Exceptions for more
information regarding processing clients using a
number of periods not supported by CSA

CLASS2 General Ledger Transactions
MICROTIQUE
CLASS 2ND
EDITION Field
Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting
Field Name

Comments and additional information

Ref Tasks | Transaction Entry
Reference

See Conversion Notes and Exceptions for more
information on the conversion of the Ref numbers.

MM DD Tasks | Transaction Entry
Transaction Date

CSA requires a year to be entered for any transaction
date. MTQ only requires the period and day to be
entered. The conversion has placed the appropriate
year on each transaction converted, based on the
clients’ Previous and Current Period Ended dates.

Account Tasks | Transaction Entry
Account Number

See Conversion Notes and Exceptions for more
information on the conversion of the account
numbers

Description Tasks | Transaction Entry
Description

Amount Tasks | Transaction Entry
Amount
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CLASS2 Employee Information
MICROTIQUE
CLASS 2ND
EDITION Field
Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Emp/Vendor# Setup | Employees
General tab
ID

Name Setup | Employees
General tab
First

CLASS2 stores the entire name in a single field. The
conversion will parse the field in the same manner
CLASS2 parses for payroll reports.

Name Setup | Employees
General tab
MI

CLASS2 stores the entire name in a single field. The
conversion will parse the field in the same manner
CLASS2 parses for payroll reports.

Name Setup | Employees
General tab
Last

CLASS2 stores the entire name in a single field. The
conversion will parse the field in the same manner
CLASS2 parses for payroll reports.

Street Setup | Employees
General tab
Street

City,St,Zip Setup | Employees
General tab
City

CLASS2 stores the city, state and zip in a single field.
The conversion will parse the field in the same
manner CLASS2 parses for payroll reports.

City,St,Zip Setup | Employees
General tab
State

CLASS2 stores the city, state and zip in a single field.
The conversion will parse the field in the same
manner CLASS2 parses for payroll reports

City,St,Zip Setup | Employees
General tab
Zip

CLASS2 stores the city, state and zip in a single field.
The conversion will parse the field in the same
manner CLASS2 parses for payroll reports

Soc. Sec# Setup | Employees
General tab
SSN/EIN

State Code Setup | Employees
Tax Withholding and Deduction tab
State W/H Properties button
State

Local Code Setup | Employees
Tax Withholding and Deduction tab
Local W/H properties button
Locality

State Code Setup | Employees
Other tab | SUTA G/L Accounts
State
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CLASS2 Employee Earnings Balances
MICROTIQUE
CLASS 2ND

EDITION Field
Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Current Quarter
Year to Date
GROSS

Setup | Employees
Earnings tab
Wages

See Conversion Notes and Exceptions for more
information on the conversion of the earnings code
GROSS.

Current Quarter
Year to Date
GROSS

Setup | Employees
Earnings tab
Salaried Wages

See Conversion Notes and Exceptions for more
information on the conversion of the earnings code
GROSS

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Earnings tab
Overtime

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 3 Overtime in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field.

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Earnings tab
Commissions

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 4 Commissions in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Earnings tab
Bonus

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 5 Bonus in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Earnings tab
Sick Pay

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 6 Sick Pay in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Earnings tab
Vacation

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 7 Vacation Pay in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Earnings tab
Reported Tips

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 8 Tips in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field

Tips in CLASS2 are included in gross pay and as a
deduction for proper inclusion on the W2. If tips
exist in this field, the gross pay field has been
reduced by the amount in this field automatically.

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Earnings tab
EIC Advance

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 9 EIC in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Earnings tab
Other Wages

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 10 Other Wages in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field

Current Quarter
Year to Date
SOC

Setup | Employees
Tax Withholdings and Deductions
tab
FICA-SS

Amounts in the CLASS2 code SOC field will be
converted to this field.
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MICROTIQUE
CLASS 2ND

EDITION Field
Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Current Quarter
Year to Date
MED

Setup | Employees
Tax Withholdings and Deductions
tab
FICA-Med

Amounts in the CLASS2 code MED field will be
converted to this field.

Current Quarter
Year to Date
FWH

Setup | Employees
Tax Withholdings and Deductions
tab
Federal W/H

Amounts in the CLASS2 code FWH field will be
converted to this field.

Current Quarter
Year to Date
STE

Setup | Employees
Tax Withholdings and Deductions
tab
State W/H

Amounts in the CLASS2 code field STE will be
converted to this field.

Current Quarter
Year to Date
SDI

Setup | Employees
Tax Withholdings and Deductions
tab
Local W/H

Amounts in the CLASS2 code field SDI will be
converted to this field.

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Tax Withholdings and Deductions
tab
401K % of Gross

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 11 401k Contributions in the
Transfer of Miscellaneous Additions/Deductions
screen will be converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Tax Withholdings and Deductions
tab
Cafe % of Gross

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 12 Cafeteria Plan in the Transfer
of Miscellaneous Additions/Deductions screen will
be converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Tax Withholdings and Deductions
tab
Loan Repayment

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 13 Loan Repayment in the
Transfer of Miscellaneous Additions/Deductions
screen will be converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Tax Withholdings and Deductions
tab
Medical Insurance

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 14 Medical Insurance in the
Transfer of Miscellaneous Additions/Deductions
screen will be converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Tax Withholdings and Deductions
tab
Life Insurance

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 15 life Insurance in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Tax Withholdings and Deductions
tab
Meals/Lodging

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 16 Meals and Housing in the
Transfer of Miscellaneous Additions/Deductions
screen will be converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Tax Withholdings and Deductions
tab
Uniforms

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 17 Uniforms in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Tax Withholdings and Deductions
tab
Union Dues

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 18 Union Dues in the Transfer of
Miscellaneous Additions/Deductions screen will be
converted to this field



(Over)

Microtique CLASS 2nd Edition to Creative Solutions Accounting Conversion Guide TL4266
© Copyright 1999, Creative Solutions. All rights reserved. Page 7

MICROTIQUE
CLASS 2ND

EDITION Field
Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Direct Deposit tab
Amount

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 19 Direct Deposit in the Transfer
of Miscellaneous Additions/Deductions screen will
be converted to this field

Current Quarter
Year to Date
MD1-MD11

Setup | Employees
Tax Withholdings and Deductions
tab
Other Deductions

Any CLASS2 payroll code (MD1-MD11) which was
translated to CSI# 20 Other Withholdings in the
Transfer of Miscellaneous Additions/Deductions
screen will be converted to this field

CLASS2 Vendor Information
MICROTIQUE
CLASS 2ND
EDITION Field
Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Emp/Vendor# Setup | Vendors
General tab
Vendor ID

Name Setup | Vendors
General tab
Name

The CLASS2 Name field is 25 characters long. The
CSA Name field is 15 characters long. Only the 1st 15
characters of the name will be converted

Street Setup | Vendors
General tab
Street

City,St,Zip Setup | Vendors
General tab
City

CLASS2 allows the city, state and zip to be entered as
1 field. The conversion will parse the city, state and
zip code from the CLASS2 field and convert to the
appropriate CSA field the same way it is done for the
CLASS2 payroll reports.

City,St,Zip Setup | Vendors
General tab
State

CLASS2 allows the city, state and zip to be entered as
1 field. The conversion will parse the city, state and
zip code from the CLASS2 field and convert to the
appropriate CSA field the same way it is done for the
CLASS2 payroll reports.

City,St,Zip Setup | Vendors
General tab
Zip

CLASS2 allows the city, state and zip to be entered as
1 field. The conversion will parse the city, state and
zip code from the CLASS2 field and convert to the
appropriate CSA field the same way it is done for the
CLASS2 payroll reports.

SSN/Federal ID Setup | Vendors
General tab
SSN/Federal ID

The SSN or FEIN will be converted based upon the
formatting entered in CLASS2.

Amount Setup | Vendors
Distributions tab
Year to date checks

This amount represents the year-to-date checks paid
to the vendor. It does not break the amounts up into
1099 type. If there are multiple 1099 type payments,
you will need to break this information apart in CSA
upon the completion of the conversion



(Continued)

Microtique CLASS 2nd Edition to Creative Solutions Accounting Conversion Guide TL4266
© Copyright 1999, Creative Solutions. All rights reserved. Page 8

ITEMS NOT TRANSFERRED DURING CONVERSION OF
CLASS2 DATA
Although most CLASS2 data is converted, some data cannot be converted due to differences in program features and
data structures between CLASS2 and CSA. If an item below is denoted with an asterisk (*), it is further explained in
the “Conversion Notes and Exceptions” section of this document. The following items, which cannot be converted,
are organized by CLASS2 screen.

General Client Information
Company ID, name 1 and 2, address, city, state, zip code, phone number, GL chart of accounts mask information.*
All of this information should be set up while adding the client to CSA, or you can add it later in the File / Client
Properties dialog.

Client Documents Financial Statements and Reports
General ledger reports, payroll reports, standard reports (including financial statements), other standard reports,
comparative reports, cumulative reports, client letters, and report options cannot be converted.

Prior Period G/L and Budget Balances
The History Change amounts for the previous 12 months are converted. GL balances from periods prior to these
history change amounts, as well as budget amounts, cannot be converted.

Journal Entry Information
Journal numbers and journal descriptions are not converted. Recurring and reversing journal entries are converted
only as current-period transactions.

Departmental Information
Department name cannot be converted.

Employee Information
Status, comments, FICA/FUTA/SUTA exemption markers, termination date, last check date, and amount cannot be
converted.

Payroll Transactions / Prior Earnings Balances
Check number, transaction date, employee name and amounts for the current year as well as prior years cannot be
converted. Earnings for quarters other than the current quarter in the current fiscal year end cannot be converted.

Additionally, earnings for the current period as well as prior years cannot be converted. Only the earnings for current
quarter and year-to-date can be converted to enable you to process W-2s and current-quarter payroll reports.

Vendor Information
1099 type, division, direct sales marker, last check number and date, 1099-R Distribution Code, 1099-R Total
Distribution marker, and 1099-R IRA/SEP/Simple marker cannot be converted.

Tax Line Grouping Codes
Because CLASS2 allows you to enter tax line grouping codes for a number of different tax products, it is impossible
to determine that the tax line grouping code entered is for UltraTax (DOS) or UltraTax for Windows. The tax line
codes will therefore need to be manually entered once the conversion has been completed.
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Other Information
Bank reconciliation information, loan amortization information, data connection information, employer/vendor
information such as Federal and State ID#, state tax code, first vendor number, employer SUI rate, dependent care
exemption amount, and employer tax accrual GL account numbers cannot be converted.

CONVERSION NOTES AND EXCEPTIONS
The following section details all known conversion exceptions between CLASS2 data and the converted CSA data.
Conversion exceptions may include differences in field lengths between CLASS2 and CSA, required parsing of
information from one field in CLASS2 to multiple fields in CSA, and manipulation of CLASS2 data to conform with
CSA requirements, and so forth.

GL Transactions – Blank Reference Numbers
Transactions that did not contain a reference in CLASS2 are converted using the reference NONE.

GL Transactions – Current Period vs Prior Periods in the Current Fiscal Year
GL transactions will be automatically converted for the current period within the current fiscal year. In order for
transactions to convert for other periods within the current fiscal year end, you will need to convert the transactions
directly from the archive path setup in CLASS2.

Note: Transactions for periods prior to the current fiscal year cannot be converted.

Chart of Accounts Mask
The CSA Chart of Account Mask is similar in structure to the general ledger account mask in CLASS2. However,
there are a few minor differences that need to be accounted for prior to converting your clients.

•  CSA does not require you to include zeros to the right of the decimal point in an account number (sub-accounts).
Example: An account in CSA might read 635 while the same account in CLASS2 would read 635.00. If the
CLASS2 client being converted does not use the digits to the right of the decimal point in any account numbers
(if all accounts are .00), the conversion will eliminate the zeros to the right of the decimal point.

•  CSA does not recognize a department 00, which is used in CLASS2 for the consolidation accounts.
Example: A CLASS2 consolidating account of 111100.00 will convert to CSA as 1111, thus eliminating the 00
for the department. All other departments (01-99) will still be converted.

•  CSA requires that department numbers be located to the left of the core account number. Therefore, if a CLASS2
client’s account mask is XXXXDD.SS, where X is the core account number, D is the division and S is the sub-
account number, it will be converted as a DDXXX.SS format in CSA. It should be noted that only the account
numbers convert. The conversion utility does not convert the actual mask. The Chart of Account Mask should be
entered when you add each new client prior to importing the converted file.

CSA Combining Accounts
CLASS2 departments are functionally similar to CSA departments, with one significant difference. CSA allows you to
define “combining” accounts, which link individual department accounts and combine their amounts for reporting
purposes. No transactions can be posted to a combining account and no balances need to be entered. These accounts
are simply used to combine general balances for accounts that have already been posted to. The combining accounts
in CLASS2 are converted but must be identified in CSA as combining accounts. For more information about setting up
and using combining accounts, start the CSA program, choose Help / CSA Help Topics, click the Index tab in the
Help dialog, and type Combining accounts setup.
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Clients Using Processing Periods Other Than Annual, Quarterly, or Monthly
CSA allows you to process clients using Annual, Quarterly, Monthly, 13 periods (not available in CLASS2), or weekly
(not available in CLASS2). CLASS2 allows for the processing of clients using 2, 3, 5, 6, 7, 8, and 11 periods.

Example: If you convert a client that is a two-period processor, balances are converted to the second- and fourth-
quarter balance fields in CSA. You would need to add this client to CSA as a quarterly processor and only use the
second and fourth quarters for processing.

All CLASS2 companies with 3,5,6,7,8,10, or 11 periods will be converted as annual clients in CSA. Therefore, when
adding such a client to CSA, you will need to add it as an annual client.

Conversion of Earnings Code GROSS
The CLASS2 to CSA conversion utility converts all occurrences of the CLASS2 earnings code GROSS to the CSA
earnings code Hourly.

VERIFYING YOUR CONVERTED DATA
Although the conversion utility has been designed to convert your data as accurately as possible, there may be some
instances when not all data converts correctly due to CLASS2 data corruption and other anomalies within the CLASS2
data. You should follow the steps below to verify that your CLASS2 data has been converted correctly.

1. Start Creative Solutions Accounting and open to the new client that was created. From the File menu, choose
Open Client. In the Open Client dialog, double-click the appropriate Client ID.

2. From CLASS2, print the GL at Page/Account Number and Trial Balance reports.
3. From CSA, print the General Ledger and Trial Balance reports.
4. Compare the two sets of reports. If the information contained on the CLASS2 reports does not match the CSA

reports, you will need to determine which transaction(s) are invalid or missing and manually enter those
transactions into CSA. Other reports are available in both systems if you cannot determine the discrepancy using
the above-listed reports.

5. From CLASS2, print the Quarterly P/R Report and Cumulative Payroll Journal report.
6. From CSA, print the Payroll Tax Summary Report.
7. Compare the amounts on the CLASS2 and CSA payroll reports and note any discrepancies. You may make

manual changes to any payroll amount in the CSA program.

If problems are encountered
If problems are encountered during the conversion of your Microtique CLASS 2nd Edition to Creative Solutions
Accounting and you are unable to reconcile the data using the various reports and tools in CSA, contact CSI Product
Support.

SUPPORT
Web Site
If you have questions or need assistance, you can visit our Web site at www.CreativeSolutions.com 24 hours a day
for the latest information on current issues and processing tips. To take advantage of this convenient means of
accessing information, choose CSI on the Web from the CSA Help menu, and then click Product Support and
Service.

Product Support
To speak with a Product Support Representative, please call the CSI HelpLine at 800-968-0600, press 3 for
accounting support, and then listen to the options available before pressing the number for Creative Solutions
Accounting. Normal weekday support is from 9:00 AM to 8:00 PM Eastern Time.
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